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Welcome to
The Pocket Zone 1.5!

This manual introduces you to the Pocket Zone version 1.5. It contains
a step-by-step installation guide,  instructions on  accessing the elec-
tronic User’s Manual, and how to get help with the program.

Also included is a basic field guide that provides you with instructions,
tips, and techniques for setting up your data collector, initializing Pocket
Zone, and shooting data points.
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Additional Help Resources
The following resources will help you get the information you need
about the program and answers to all your program questions.

An electronic User’s Manual is provided in .PDF format, and is copied
to your desktop when Pocket Zone is installed. You can also access the
.PDF file directly from the installation CD-ROM at any time. An on-line
link to the .PDF file is also available on our training site located at http:/
/training.cadzone.com.

The User’s Manual contains a command reference for every feature of
the Pocket Zone, and provides chapters on program basics, Pace
Mode, Cross Sectioning, and a Quick Start tutorial.

Pocket Zone Discussion Group
The Pocket Zone discussion group contains up-to-date notes regarding
Pocket Zone usage and related subjects. It also contains specific device
related information. It can be found on The CAD Zone’s training site
located at http://training.cadzone.com/forum/boards.asp

You can also receive help by contacting The CAD Zone directly by:

Email Support: info@cadzone.com
Phone Support: (503) 641-0334 (Mon - Fri, 7:30a.m. - 5:00p.m. pst)
FAX:  (503) 641-9077

Additionally,  periodic program updates and bug fixes are available for
download on the Pocket Zone Updates page located at
http://www.cadzone.com/update/default.htm
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Installing Pocket Zone
1) You must install Pocket Zone from a desktop (or laptop) computer
that is ActiveSync’d to your Pocket PC. Place the install CD in your
computer’s CD Drive. The installation program will automatically begin
a few moments after the CD is inserted.

2) When the first screen of the installation program appears, click on the
“Total Station Version” button.

3) Next, select the device on which you’re installing Pocket Zone. In
this example we’ll install on a TDS Recon.
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 4) Two options for the Recon will be offered. Many devices are sold
with one of two operating systems. The most popular is the Windows
CE or Pocket PC operating system. The other is the dot NET (.Net)
operating system. Compare the picture on the installation page with
your device if you’re not sure what operating system you’re using. In
this example we’ll select the Pocket PC version.

5) Make sure your Pocket PC is connected and sync’d to your com-
puter and then click “GO”.
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If you’ve installed the program previously, a message will appear with
an option to first remove the program.

6) Accept the license agreement.
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7) Enter your name and company name.

8) Pick the “Complete” setup type.
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9) If your Pocket PC is properly sync’d to your computer, the following
screen will appear followed by a prompt to install Pocket Zone into the
default application directory. Answer YES to this prompt.

10) After the data is transferred from your computer to your Pocket PC
you will be prompted to check your Pocket PC for any additional steps
to complete the installation.  Click on OK.
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11) Once installed, the Pocket Zone icon is placed in the Programs area
of your Pocket PC. Click the START pull-down, choose Programs
from the Start list, and click the Pocket Zone icon to run the program.

12) The Pocket Zone Field Guide is automatically installed on your
desktop computer.  It can be accessed any time by clicking the Start
menu, and then selecting Pocket Zone from the Program directory. The
field guide is located in the Pocket Zone directory. This guide provides
instructions on backing up your pocket PC as well as getting started
with your total station.

Troubleshooting
1) You receive the message, “program not compatible ….”

You’ve installed the wrong version of Pocket Zone for your device. For
example, you may have installed the dot Net (.net) version on your
Recon that requires the Pocket PC version.

If you’re using a device that is not shown on our installation screens and
it does not use the Pocket PC operating system, then try installing the
Ranger .net version.
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2) Program installs but doesn’t run.
You may be installing on a version of Windows CE 4.x.  If you happen
to have a unit with a widescreen and/or is a monochrome device
(display) you may need to manually copy two display DLL files onto
your device:

These two files can be found on the installation CD. Open up the install
CD with Windows Explorer (file manager) and browse to the “mono-
chrome” directory. Select the “MFC30ARM” directory to access the
required DLL files.

Next, copy these two files directly into the \Program Files\Pocket
Zone directory on your Pocket PC.

3) You receive an error message on the Pocket PC during instal-
lation, “designed for a previous version of Windows mobile…..”

Click OK and ignore this message. This is related to the installation
program and mobile operating system. Pocket Zone will override this
error and continue to run as designed.



10

4) You don’t have ActiveSync installed on your desktop computer.
ActiveSync 4.1 is now available as a download from the Microsoft
website at this address http://www.microsoft.com/windowsmobile/
downloads/activesync41.mspx

According to Microsoft, the improvements since ActiveSync 3.8 include
more robust synchronization with Outlook and more reliable USB
communication. Along with these improvements come some backwards
compatibility issues:

• The PC must be running Windows 2000 SP4 (Service Pack 4) or
Windows XP.

• Windows 98, Me, and NT are not supported by ActiveSync 4.1.
• The PC must be running Internet Explorer 6.0 or later. (Previous

versions of ActiveSync required Internet Explorer 4.01 SP1 or later.)
• ActiveSync 4.1 cannot be used to communicate with devices running

Windows CE 2.12 or older. This affects older Rangers which were
sold by TDS before March 2001. If those Rangers are upgraded to
Windows CE 3.0, they can communicate over a serial connection
with PCs running ActiveSync 4.1.

Backing up your Pocket PC
Like other Windows Mobile
devices, the Ranger X and the
Recon store files in a RAM file
system. RAM is volatile memory;
its contents will be lost if the
battery is disconnected or com-
pletely discharged. To prevent such
data loss, it is important to regularly
back up files in RAM to the "Built-
in Storage" folder, which is non-
volatile memory. Both the Ranger
X and the Recon come with a pre-
installed backup utility program
called Sprite Backup.
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Performing a backup on either unit is simple:  Choose Start > Pro-
grams > Sprite Backup > Backup Now, and then wait a few mo-
ments while the backup is created. We strongly recommend that you
perform a backup after installing new software or drivers on your
handheld PC.

It is possible to configure the Sprite Backup utility to automatically
perform a backup every day. On either the Recon or the Ranger,
choose Start > Programs > Sprite Backup > Options > Switch to
Advanced Mode > Options > Scheduled Backup. For convenience,
we recommend checking the box to "Restart device when complete."

Consider scheduling the daily backup for a time when the handheld will
not be in use.  If the handheld is asleep or off when it is time to perform
the daily backup, it will wake itself up and perform the backup.

Data Loss on Pocket PC's
What causes loss of data on your Pocket PC?

1) Dead battery.
2) Removing battery.
3) Hard Re-boot.

Unlike your desktop or laptop computer, drawings will not be saved if
your Pocket PC has a power failure. That is why it is critical that you
perform a "Backup Now" or "Sprite Backup" regularly on your system.

If you are swapping batteries on your Pocket PC be sure to backup the
unit BEFORE pulling out the battery.

NOTE: Using the backup feature on your Pocket PC saves the Pocket
Zone program and access key which allows you to use the fully licensed
Pocket Zone.
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When should you "BACKUP" your Pocket PC:

1) After installing Pocket Zone and setting up your Pocket PC.
2) After updating, installing a new version of Pocket Zone.
3) After creating a diagram in Pocket Zone.
4) Before changing batteries on your Pocket PC.

Safe places to SAVE your work:
A) “Built in S torage" is a folder on your Pocket PC that is actually
"FLASH" memory and is nonvolatile. You can save you work there and
it will remain there even in the event of a total power loss to the system.

B) You can insert "Memor y Cards"  such as Sandisk cards into your
Pocket PC and save work to that location. These are the same cards
used in digital cameras to save more pictures.

While shooting, the drawing should be saved to Main Memory. DO
NOT set up Pocket Zone to save to a memory card while shoot-
ing points. If you shoot points and save directly to the Storage Card
your system will slow down considerably. Storage Cards are too slow
to use while shooting.
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This guide helps you get started using Pocket Zone with your laser
device in the field. More comprehensive instructions are contained in the
electronic User’s Manual.

Please review the Pocket Zone User’s Manual for complete program
information and instructions not addressed in the field guide.

Pocket Zone Field Guide
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Step 1: Set up and Level your Laser Device
Level the tri-brach (screws to the tripod; the total station clips into it)
while it's on the tripod. Put one foot on the foot of the leg of the tripod
before loosening it to adjust its height. Adjust and grip the leg above the
joint to maintain control.  Try to position the bubble somewhere inside
the ring , it doesn't have to be perfectly centered at this point.

Next level the instrument. Turn the face so it is parallel to any two
thumbscrews. Turn the screws equal but opposite to one another
(simultaneously) until the bubble on the instrument is centered.

Finally, turn the instrument 90 degrees so the face is parallel to the
remaining thumbscrews. Turn only that one thumbscrew until the bubble
is centered.
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Step 2: Mark Station Location
Using the optical, laser, or string plummet, drive a P-K nail and washer
in the ground to mark the station location. Pounding in P-K nails into the
street can be made easier and simpler by using a 2lb sledge and vice
grips to hold onto the nail.

Note: Using washers with the nails or painting over the nails allows for
easier relocation if you need to return to the original set-up position.

Step 3: Establishing a Reference (Zero) Point
From the station location (P-K nail) run a tape measure out 30' to 50' in
the direction of your zero set (North). At the end of the tape place
another P-K nail and washer.

Establishing this fixed reference point serves three purposes.

1) Verifies the accuracy of the first shot taken by measuring the
shot on the Pocket Zone screen and comparing that value and
direction with the actual (tape measured) point.
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2) At the end of shooting the scene you can shoot the initial
reference point again. This last shot should land very close to
the initial reference shot. This establishes the accuracy of your
shoot, and is beneficial if you’ve moved the laser device during
the shoot and want to verify that accuracy was maintained.

3) If the laser device was bumped, moved, knocked over, or
shutdown, you would have to setup and reinitialize the system.
You can continue shooting in your current drawing by leveling
and centering the laser device over the established station point
and zero set off of the existing reference point. This reorients
you your existing diagram and allows you to continue shooting.
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Step 4: Zero Set the Laser Device
Zero set the laser device along the same line as the tape. Refer to your
laser device’s documentation  for the specific instructions on  zero
setting your individual device.

Note: Nikon drivers prompt the user to "Point Device to Diagram
Top". When the user clicks OK the Nikon total station zero sets itself in
the direction the device is pointing.

Step 5: Star t Pocket Zone
With the Pocket PC connected to the laser device, open  Pocket Zone.
From the opening screen, enter a file name. Set the units to Feet or
Meters. Pick a Description file (Police or Fire) from the drop down
menu and click OK.
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Step 6: Pick your Laser Device Driver
From the File menu select "Laser Device" and pick the driver for
your device.

Note: Your communication settings on your laser device must match the
driver settings in Pocket Zone. Most likely, the Pocket Zone settings
will coincide with the settings on your device. Refer to the documenta-
tion for your specific laser device for comm. setting instructions.
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Step 7: Set Instrument and Reflector Height
After selecting your laser driver you will be prompted to set the instru-
ment height and reflector height. If you have set up your laser device to
shoot in "reflector-less" mode then un-check “Use Reflector” box.

Instrument Height
The height (offset from the ground to the lens) of the total station is
taken into consideration when the shot is taken. This offset is subtracted
from the shot, making the reference point at ground level.

Use Reflector
If the “Use Reflector” box has been checked and the reflector height set
correctly, the height of the reflector will be subtracted from the shot.

Reflector-less
If the “Use Reflector” box is un-checked then the shot will take as is.
For example, if you shot a six foot height reflector and the “Use Reflec-
tor” box was un-checked you would be adding six feet to the overall
elevation of the shot.
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Note: You do not need to re-select your device driver to switch
between reflector and reflector-less mode. If you're using a reflector-
less system and switching between reflector and reflector-less mode
during the shooting of your scene,  be sure to check or un-check the
“Use Reflector” box in the "Instrument Settings"  dialog.

Step 8: Take your First Shot
Take your first shot to the end of the tape (nail) along your zero set line.
This will give you a good test shot for distance and direction and will
allow you to set up the station at that same location at a later time.

How does Pocket Zone interpret the data from the total station
or laser device?
 Pocket Zone is a true CADD program and has double precision,
floating point accuracy. The values are accurate to 16 decimal places.

If the laser device has the capability, it computes the X,Y,Z coordinates.
Most devices cannot (TopCons are the notable exception), so the
coordinates are computed based on the slope distance, horizontal, and
vertical angles of the instrument.

The raw data is stored with every shot; so by looking at the point list
file, and examining the raw data, you could hand calculate the coordi-
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nate value to verify the X,Y,Z results. The RAW data is encrypted with
the actual Pocket Zone diagram and can't be modified.

Shooting a Total Station
Fire your total station by clicking on the Fire button in Pocket Zone.
When the driver has been selected, the Fire button will turn from grey to
red.

You can also fire the total station from your Pocket PC keypad. On a
HP IPAQ you press the middle of the rocker button to fire the total
station. From a Pocket PC with built in keypad or Windows buttons,
you can press the Enter key to fire the total station.

IMPORTANT!
Shooting an Impulse Laser (LTI, Laser Atlanta, Contour)
If you’re shooting with an impulse laser, such as an Laser Technology
(LTI) device, you must fire the impulse manually. The Fire button will
NOT turn red in Pocket Zone when this type of device is selected.
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The First Shot
When the first shot is taken and recorded by Pocket Zone, two points
are displayed on the screen. Point 1 is the instrument location and point
2 is the first target shot.

Listen to Pocket Zone
When you fire your total station from Pocket Zone you should hear a
“laser” sound effect. You can adjust the volume on your pocket PC if
you don’t hear anything or it’s too low. When Pocket Zone accepts the
shot data from the laser device you will hear another “success” sound.

Once you’re familiar with these sounds, they will help you in the field to
determine if you registered a successful shot. If you don’t hear the
“success” sound, or you hear something different, you may have an
error on your laser device or something else didn’t allow Pocket Zone
to accept the shot.
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Step 9: Measure between Points 1 and 2
Use the “Measure Distance” command to measure between any two
points. All measurement data between those points  will be displayed.

Step 10: Continue Shooting the Scene/ Add Descriptions
Descriptions are used to label the shots taken at the scene. Depending
on the description selected, it could also be assigned a color, layer, layer
name, symbol, or line type.

Choose a description from the pull-
down list of descriptions. It is NOT
necessary to pick the Point feature
to shoot a point.

Note: The description is NOT reset
back to "No Desc" after shooting a
point. Don’t forget to change your
description to a new description or
"No Desc" when required.



24

Shoot Lines, Ar cs, or Curves
Pocket Zone is a combination data collection program and mini-cad
program. Think of the laser device as your mouse. Instead of point and
click, you point and shoot. You can shoot multiple points and then
connect the points with a continuous line, curve, 3pt arc, or single line
(2pt line). Select the line, arc, or curve before shooting and then take
your shots. The shot points will be displayed as well as the geometry.

Single Line: The Line is drawn after the second point is shot.
3 Point Arc: Arc is drawn after the third point shot.
Continuous Line: Line is complete only when you click on the
“OK” button.
Curve: Curve is complete only when you click on the “OK”
button.

Display (Remove the Clutter)
Each shot taken includes a point, point number, elevation, and a symbol.
After recording multiple shots your pocket zone display may become
too cluttered to view easily. You can hide the different display elements
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using the “Display Options” feature. Open the dialog and un-check the
items you wish to hide to reduce the data on the screen.

Reposition Instrument (Backsite)
 During a shoot it might be necessary to move the laser device to record
points not accessible from your current position. Use Reposition
Instrument to reposition the instrument using the “backsite” method.

You’ll be prompted to shoot the point of your new location. Then you’ll
be prompted to move your device to the new location and click OK.
After moving the device, make sure to level it again before shooting
additional points. You are then prompted to enter the instrument and
reflector height. Next you’ll be prompted to shoot “back” to your
original location (the spot you just moved from.)

 Once the original location  point is shot, Pocket Zone will calculate
your new position and you can start shooting the scene again. A new
instrument symbol will be placed on the screen once you’ve reposi-
tioned. The old instrument symbol remains as well, showing  the location
of the instrument in the drawing at every position and at every move.
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Shoot Procedure to Self Check Accuracy
 Shoot a point ahead of time before repositioning. Then, when you
reposition to that point you will see the total station base symbol drop
right on top of the shot point.

 At the end of a shoot you should re-shoot the first shot taken. Your last
shot point should end up on top of the first shot point.

3pt. Locate and Reposition
Use this command  to figure the location of the instrument given three
existing points.  For example, if you have an existing diagram of a site,
you can reposition the device anywhere in the scene to record points
from a new position.  The command will ask you to shoot three known
locations and identify those locations in the diagram.  It then projects a
radius from the located diagram points to create three theoretical
circles.  The X and Y location of the instrument is the unique intersection
point of those three circles

The elevation, or “Z”, is computed independently based on the mea-
sured Z displacement of each of the three shots.  The Z displacements
are accurate because the instrument is leveled at the start of each point
collection session (standard professional procedure.)

Step 11: Save your Work
Save your data by clicking on the “disk” icon at the bottom of the
screen or selecting the Save feature from the File menu.

Auto Save
If you haven’t taken a shot for 60 seconds the program will automati-
cally save your current work. You will not be able to take another shot
until the save is complete. After each save, a backup file of the previous
save is created with a .bak extension. This is a backup of your work in
case something happens to corrupt the main file.

Point List and RAW data
Once your diagram is complete, you can save the data in your file into
other formats. From the File menu you select “Save Point List….” to
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generate an ASCII file of all of your shot points. The point list is saved
in the format, Point Number, North, East, Elevation, and Description.

You can also generate an ASCII file of all your points with the “Create
RAW Data File…” feature. This feature saves in the same format as the
point list, plus it appends the raw data to each shot as it was gathered
from the laser device.

Importing into the Diagram Program
The Pocket Zone file is saved with a .pzd extension. This file type can
be opened up directly in Crash Zone or any diagram programs by The
CAD Zone. You can also save to other file formats such as AutoCAD
.dwg or .dxf, so the data can be opened in other CAD programs.

Step 12: From the Pocket PC to your Desktop Computer
Regardless of the type of  Pocket PC you’re using it, will have some
method of synching (connecting) to your main computer. It may be a
cradle that connects to your computer that the pocket pc rests in or a
simple serial cable from the Pocket PC to your computer.

Once connected, Microsoft’s Active Sync program is the software used
to connect the two devices. Once connected, open up Windows
Explorer (File Manager) to copy the Pocket Zone file to your desktop
computer.

By default, the Pocket Zone .pzd files are saved to the Diagrams folder
on your pocket pc. From your Pocket PC, copy the .pzd file to your
diagrams folder on your desktop computer.

Open up Crash Zone, select File Open, choose .pzd as your file type,
select and open the .pzd file. Once opened in the diagram program it
becomes a .czd file (cad zone diagram). The first time it’s saved it will
be saved with the .czd extension. This method leaves the .pzd file intact
and un-edited to maintain integrity of the collected evidence.
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Sync PDA to Desktop
a) Plug the USB cable into PDA (or put PDA in cradle).
b) You should see the Active Sync icon on the task bar (bottom
right of computer screen) turn green and spin.
c) A screen called “Set up a Partnership” will appear, or show
up on the task bar.
d) Choose the NO radio button, it’s not necessary to set up a
partnership to sync the two devices.
e) Choose Next and the Active Sync dialogue box will appear
telling you that you are connected.
f) Minimize the Active Sync dialog.

Find your Pocket Zone Diagram
g) Right click on the My Computer icon on your screen or the
Start button at the bottom left of your screen and choose
Explore.
h) Find the Mobile Device folder.
i) Click on Mobile Device. (You are now looking at the files on
the PDA and NOT the desktop computer).
j) Click on the plus sign to the left of Mobile Device (this will
expand the folder tree for the PDA).
k) Click on plus sign to the left of My Computer. This will
expand the folder tree for My Computer on the PDA.
l) Click on the plus sign to the left of My Documents.
m) Click on the Diagrams folder. This is the location of all pzd
files created on the pocket pc.

Move the Pocket Zone Diagram to the Desktop Computer
n) Select the diagram(s) you want to copy to the desktop
computer.
o) Hold your stylus down on the selected diagram(s) and don’t
let up until the copy / paste menu pops up. Select Copy from
this menu.
p) Paste the diagram(s) into the folder which you have desig-
nated for storing your Crash Zone drawings on your desktop
computer.
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q) Open up Crash Zone. Click Open from the File pull-down
menu.
r) Select .pzd as your file type.
s) Locate the .pzd file.
t) Double click on that file and it will open in Crash Zone.
u) Modify the diagram as needed.
v) Save the drawing. It will automatically be saved with the .czd
extension.

Step 13: Helpful Tips
Handwriting Recognition
Transcriber is the handwriting recognition software on your Pocket PC.
You might find using the transcriber method faster than searching for
keys on the on-screen keyboard.

Transcriber can be activated by selecting the up-arrow next to the input
selection icon (looks like a keyboard) at the bottom of the screen and
choosing Transcriber. Once Transcriber is launched, an icon that looks
like a hand holding a pencil appears.

Examples for using Transcriber:
a) Quick Description Selection.

Click on the Description pull down list.
Anywhere on your screen, handwrite the first letter or letters of
the description you want and let up with the stylus. The list will
automatically move to descriptions beginning with that letter or
letters.

b) Place Text.
Start the Text command.
Click once in the text entry box to start a flashing cursor.
Handwrite your text notes.
Click in the text size box and change your text size. Backspace
over the existing value and write in another.
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c) More Examples.
Enter your file name when starting Pocket Zone or saving a file.
Add Notes to an object by selecting it with the Object Info
command.

Step 14: Set Up in an Existing Scene (.pzd file)
Working fr om the First Total Station Reference Point
At some point you may need to set up your laser device and Pocket
Zone to work within a scene you’ve completed. This could happen for
a number of reasons such as leaving the scene and returning later for
more data or something happened to the equipment that requires you to
set up again.

If you established an instrument location point (PK nail or other marker)
and you established your first shot point as a zero reference point, you
can work in the existing drawing. Set up and level the instrument over
the first point. Zero set the instrument on the second point established
earlier when the job was first started.

Start Pocket Zone and open the desired file. Select your “laser device”
driver. Set your instrument height settings to reflect the new settings.
Because you’re set up on the reference point previously established in
the Pocket Zone drawing and you zero set the instrument in the same
direction previously used, you can start shooting new points in the old
drawing. Be sure to shoot a couple of previously shot points to verify
the new shots are accurate (they should fall on top of, or  very close to
the old shots).

3 Pt Locate and Reposition
The 3Pt Locate and Repositioning command is located on the File menu
in Pocket Zone. By setting up the total station anywhere in the previ-
ously shot scene you can re-establish yourself back in an existing file by
shooting three previously shot points while clicking on the same point in
the Pocket Zone diagram.  See the Pocket Zone manual for more
information on this feature.
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Merge Multiple Pocket Zone files in Crash Zone
You can create multiple Pocket Zone drawings from a single scene. You
might want to shoot the roadway and save it, start a new file, shoot the
crashed vehicles from the same scene and save them as well. Open up
the first file (roadway) in Crash Zone, then, use the Merge feature to
bring in the second file (vehicles).

Both files need to have at least two points in common to be accurately
aligned to each other. See the “Align Common Points” documenta-
tion in the on-line help in the diagram program.

Step 15: Troubleshooting
1) Before running Pocket Zone, close out all other programs and reset
the Pocket PC. This will ensure there is sufficient memory.

2) The Pocket PC should be connected and turned ON before turning
on the total station.

3) If you need to stop shooting for a while and you want to save battery
power on your Pocket PC you can power down while still in Pocket
Zone. Do NOT exit out of Pocket Zone or you’ll have to re-open the
drawing and re-establish the total station location in the drawing. Simply
POWER DOWN and do not exit the job so it will keep your current
set up location. If you need to re-establish the position of the total
station within the drawing, refer to the notes in Step 14 above.

4) If you’re having communication problems between Pocket Zone and
your laser device try clicking the “Reset COM Port” command on the
File menu.

5) Shots out of sync: If you have trouble getting a shot and then the next
shot is placed in the previous shot's location you should reselect the
laser device driver. Reselecting the driver will not affect your current
station location. You can also try clicking the “Reset COM Port”
command on the File menu.



32

6) Units on your total station should match units you're using in Pocket
Zone (Feet or Meters). Check both the total station settings and Pocket
Zone settings.

7) Data Send Failed: If you get a "Data Send Failed" error message in
Pocket Zone when trying to take a shot it means the com port on the
Pocket PC is not active.

a) Reset the pocket pc.
b) Run Pocket Zone and re-select the laser device driver.
c) If you try to start a new file while shooting in Pocket Zone
you have to re-select the laser device driver. Closing Pocket
Zone or selecting "New" will disengage the com port.

8) More Communication Trouble:

a) Make sure you do not have software that's taking control of
the com port such as an external keypad program. If so, you
need to open the keyboard software and click the "disable"
box.
b) Make sure you've selected the correct driver for your laser
device.
c) Make sure the communication settings on the laser device
match the driver settings.
d) Make sure your cable is plugged in correctly. Check your
cable ends for bent prongs.
e) Start up and zero set the laser device, connect the Pocket
PC and run Pocket Zone.

Pocket Cross Section Mode
Cross Section mode allows you to shoot points out of order, while
automatically drawing a line, arc, or curve, between points with like
descriptions. Regardless of the sequence in which you shoot the points,
lines, arcs, or curves are automatically connected between points with
the same description.

This following example is a simple roadway created with Cross Section
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mode. The shots were taken top to bottom, from left to the right. EP1,
at the top left of the drawing, was shot first, then CL1 below it, and
EP2 below that. Then, moving to the right, EP2 was shot, then CL1,
then up to EP1; continuing until the roadway was completed.

The Selected line, arc, or curve is automatically drawn between points
with the same description as the shots are taken. If Cross Section was
not being used, all of the EP1 shots would need to be taken in sequence
to connect a line or curve between them.

In Cross Section mode, the selected tool (a line, arc, etc.) remains
active until you click “OK”, or until you exit Cross Section mode. Upon
exiting, Cross Section automatically finishes any continuous lines or
curves that are active.
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Using Cross Section Mode
To record data in Cross Section mode:

1) Click on the “Cross Section Mode” button.

2) Pick a description from the Cross Section pull-down list.

Note: You cannot use the standard description pull-down list while in
Cross Section mode. The standard list remains grayed out until you
close Cross Section.

Active Code [x]
The Cross Section description list displays an [x] next to any active,
unfinished description that has not been completed by clicking OK. For
instance, if two shots were recorded using the EP1 description and OK
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was not pressed, an [x] appears next to the EP1 description on the pull-
down menu. The [x] indicates the EP1 sequence is still active, but
allows you to record other data shots without affecting EP1 data.

3) Select the drawing entity (line, arc, or curve, etc.) you want
drawn between the points with the selected description.

Don’t select an entity if you just wish to shoot points. You do not need
to select the Point command when recording data points with the data
collector; only select Point when you are manually placing points in the
drawing.

Note: A single line will only connect between two points and then finish.
An arc will only connect between three points and then finish.

You can change the entity connected to a specific description by
selecting a different entity at the beginning of the next shot. You will be
prompted whether or not you want the new entity to begin from the last
point. For example, this allows you to change from a line to a curve
along a stretch of road, creating a smoother transition in the drawing.
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4) When finished shooting in Cross Section mode, click the Cross
Section mode button.

Cross Section closes, and any unfinished lines and curves with the same
description will automatically be completed. Consecutively, Cross
Section descriptions with an active [x] code are automatically com-
pleted.

Customizing Your Cross Section Description List
The Cross Section Description List can be customized by editing the
“CrossSections.txt” file located in the Pocket Zone directory on your
Pocket PC.

The Cross Section description file differs from the standard descrip-
tions, in that there is no description added to the text line.

For example, in Standard Descriptions “Edge of Pavement would
appear like so:

EP1,Edge Pavement, Layer=12, Layer=Scene, color=0,
linetype=solid

The same description is entered in Cross Section like this:

EP1, Layer=12, Layer=Scene, color=0, linetype=solid

Add Cross Section descriptions at any time using the “Custom” feature
on the Cross Section pull-down list. The order of the descriptions in
your list mirrors the order the list as it was created in the text file.
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The following is an example of a CrossSections.txt file:

CL1, Layer=12, Layer=Scene, color=0, linetype=solid
CL2, Layer=12, Layer=Scene, color=0, linetype=solid
CL3, Layer=12, Layer=Scene, color=0, linetype=solid
CL4, Layer=12, Layer=Scene, color=0, linetype=solid
CL5, Layer=12, Layer=Scene, color=0, linetype=solid
CL6, Layer=12, Layer=Scene, color=0, linetype=solid
DL, Layer=12, Layer=Scene, color=0, linetype=cz2_skid_4
EP1, Layer=12, Layer=Scene, color=0, linetype=solid
EP2, Layer=12, Layer=Scene, color=0, linetype=solid
FL1, Layer=12, Layer=Scene, color=0, linetype=solid
FL2, Layer=12, Layer=Scene, color=0, linetype=solid
JB, Layer=12, Layer=Scene, color=0, linetype=solid
MED1, Layer=12, Layer=Scene, color=0, linetype=solid
MED2, Layer=12, Layer=Scene, color=0, linetype=solid
RRT1, Layer=12, Layer=Scene, color=0, linetype=cz1_rxr
RRT2, Layer=12, Layer=Scene, color=0, linetype=cz1_rxr
YL1, Layer=12, Layer=Scene, color=0, linetype=solid

The Final Step
When you Finish your Job in Pocket Zone you need to make sure to
save three files:

1) The Pocket Zone file (.PZD extension)

2) Coordinate list (.TXT extension).  To create this go to the
"SAVE POINT LIST" in the Pocket Zone program under the
FILE pull-down menu.

3) Raw Data file (.RAW file extension). To create this go to
"CREATE RAW DATA FILE" in the Pocket Zone Program
under the FILE pull-down menu.

These files all Save to the C:/DIAGRAMS folder in Pocket Zone
on your Pocket PC.  Keep the NAMING convention the SAME to
assist in keeping the correct files together.
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Save the three files generated with Pocket Zone, as well as your
finished Crash Zone drawing (.CZD file), for a total of four files for
every job you do.

Burn all four files to a CD and keep these in your case folder . It is also
recommended that you create a secondary back up of the files on your
computer, and additionally to a server or other back-up storage device.
Files can be corrupted or lost, so be sure to have your data backed-up
in more than one location.


